
BTM200 – Chapter on Access 

There are four types of commonly-used objects : tables, queries, forms and reports. 
The two less commonly used are macros and modules. 
The navigation pane organizes and lists the database objects in an Access database. 
The Access Ribbon is what contains the icons that enable us to perform functions to maintain our 
database. 
Database fils should be named using meaningul names and stored in meaningful folders and subfolders. 
Backing up regularly is essential. 
Access databases increase in size over time. Compacting the databases avoids loss of data, recovers 
unclaimed space, defragments fragmented databases and repairs corrupt databases. It’s therefore a good 
thing to do. 
Share -> Save Database As -> Access Database or Back Up Database, etc. 
Default extension given to a database that has been backed up is accdb. (Default file name!) 
Filters display a subset of records based on specific criteria. They wll always display the entire record 
selected based on the criteria selected. All extracted data must be contained within a single table and the 
function also does not delete unwanted records (simply hides them). 
There are two types of filters : by selection and by form. 
Filters by selection only displays records that match selected criteria. To implement them, click any cell 
that contains the specific criterion, click “ Filter by Selection “, in the “ Sort & Filter “ group. Then, select “ 
Equals [criterion] “ from the list of options. Et voilà ! 
Filters by form displays table records based on multiple criteria. It allows the use of AND and OR 
conditions. It also allows the use of comparison operators like greater than, less than, greater than or equal 
to, less than or equal to, etc. ANDs restrict selection criteria, ORs expand selection criteria. 

Access has a Relational Databases Management System (RDBMS). It allows the user to create 
relationships between tables. 
Relationships are set(s) of rules on how tables will be related. A good database table design is based on 
normalization. 

Use EXCEL if Use ACCESS if

- I am more comfortable with it 
- I only need one worksheet to handle all of my 

data 
- I have mostly numerical data 
- Requires subtotals and totals for worksheet 
- Want to use “what if” scenarios on data 
- Need to create complex charts and/or graphs 

- I need ultiple related tables to store data 
- Have a large amount of data 
- Need to connect to and retrieve data from 

external databases ( Microsoft SQL Server, for 
instance) 

- Need to group, sort, make the sum of total 
data based on criteria 

- Need mutiple users to have access to the 
application simultaneously 

- Need built-in tools to help organize data 
- Need the ability to create relationships 

between tables



A common field is commonly used to relate two tables together. Join lines allow relationships between two 
tables to be created on a common field.  
There are three types of relationships used by Access to manage relationships between tables : 
- Enforce referential integrity 
- Cascade update related fields 
- Cascade delete related records 
Relationships should be created after tables are made, but before any sample data is entered. These 
relationships wll be represented by join lines in the Relationships window. The most common method of 
connecting two tables is to use a primary key from the primary table to the foreign key in the related table. 
In Relationship Tools, tables will be displayed and join lines will link one to another. 
Referential integrity is a function ensuring that data cannot be entered into a related table unless it first 
exists in the primary table. For example, if a company only enables those who are members (IDs in a table) 
to purchase a good, then the purchase will be made only if the person has a valid ID. 
Using sample data is useful before entering any real data, in order to test the accuracy, the usefulness of 
the tables created. 

Designing Fields Guidelines 
1) Include the necessary data : Draft of reports and selection of what is necessary. 
2) Design for now and the future : Anticipation and incorporation of flexibility. 
3) Store data in its smallest parts : No full name for the field, division of data and flexibility, always. 
4) Add calculated fields into another table : Be cautious because it can turn into a problem! 
5) Design to accommodate date arithmetic : Calculated fields can create it, there are many examples. 
6) Link tables using common fields : Join lines may be manually created by the users of automatically by 

Access (if 2 fields share the same name) and be cautious to avoid any error (unnecessary storage). 

Creating Tables import data from another database or application and enters data directly into rows in 
Datasheet view. 
Create Fields -> Design View 
Field names should be meaningful, contain up to 64 characters, should restrict to letters, numbers and 
spaces and, as Access allows it, use CamelCase notation. Uppercase letters should be put as the first 
letter of each new word (especially useful when no space in the name). 
Every field has a data type. It determines the type of data that can be entered and the operations that can 
be performed on that data. Access recognize 10 different data types : Number, Text, Memo, Date/Time, 
Currency, Yes/No, OLE, AutoNumber, Hyperlink and Attachment. 
A Foreign Key Review is a field in one table that is also a primary key of another table, for instance the 
Speaker’s ID is the primary key of the Speakers Table and the foreign key in the Session Speaker Table. 
Table views include Design View, PivotTable and PivotChart. 
Work with Field Properties : field property, text data type, number data type, caption property and validation 
rule. Access Field Properties include Field Size, Format, Input Mask, Caption, Default Value, Vaidation 
Rule, Validation Text, Required (stuff), Allow Zero Length, Indexed, Expression and Result Type. 
Understanding Table Relationships allow a more efficient combination of data from related tables. Then, I 
can create queries, forms and reports. 
Establishing Referential Integrity can be done in the Edit section of the Relationships dialogue box 
(Relationship Tools). I must select ‘Enforce Referential Integrity’ checkbox. 



To set cascade options: 1) ‘Enforce Referential Integrity’, 2) ‘Cascade Update’, the second option, if I want 
to update related fields OR 3) ‘Cascade Delete’ if I need to delete related records, which is the third and 
last option in the Relationships Dialogue box. 
Indexing to retrieve data quickly first provides quick sorting based on the primary key, but also quick 
retrieval of data based on the primari key. 
Options on External Data Tab include Import & Link, Export, Collect Data and Web Linked Lists. 
For instance, click ‘Excel’ to import spreadsheet data from Excel. Then, click ‘Browse’ to find a specific 
spreadsheet and then decide what I want to do with it (import, append a copy of link the data to create a 
linked table…). Afterwards, I will have to select the spreadsheet to import, because an Excel document can 
include several different spreadsheets.  After clicking on ‘Next’, I must verify the columns, the Indexed 
Properties to YES, select the primary key and verify the table’s new name. 
The three types of relationships are One-To-One, One-To-Many and Many-To-Many. 
Establishing a One-To-Many relationship can be done in opening the Relationship Tools window, add tables 
and establish relationships. I will now see that two join lines will spread out from a single table. The infinity 
symbol means that there could be many different join lines/sides. 
Single-Table Queries can be accessed in Query Design – Tables and I can then add which design grid to 
add in the three categories, Fields, Sorting and Criteria. 
Specifying criteria for different data types can be done as knowing the field data type, setting delimiters 
and then the criteria to be specified. 
Wildcards are substitutes for letters (?) or combination of letters (*) that will include all possibilities that 
exist. For instance, H?LL will retrieve Hall, Hill and Hull.  
Operators are used to limit the results of a query. 
Operand is the part of the expression that is being operated on. 
Null and Zero-Length Strings seem to work like statistical hypothesis testing (null or not null). 
Query Sort determines the order of records from left to right. 
And Operator : only fill the section ‘Criteria’ for two selected categories. 
Or Operator : fill ‘Or’ for the first and ‘Criteria’ for the other (or ‘Or and ‘Criteria’ for the same). 
Not Operator : fill ‘Criteria’ for only one category. 
To use the Query Wizard, launch it from the Create tab and modify the fields by moving or deleting them 
as well as the data, which can be selected in detail or summarized. 
Multi-Table Queries allow multiple tables that are already related to each other. It is similar to creating a 
singe-table query. 
The order of operations is the same as in Excel : 1) Parentheses, 2) Exponentiation, 3) Multiplication, 4) 
Division, 5) Addition and 6) Substraction. 
Creating a calculated field in a query can be done with using expressions, in which elements are involved 
according to a specific syntax Two points instead of equal sign and [] instead of parentheses. For instance, 
EmployeePay: [Hourly Rate]*[HoursWorked] –Calculated fields cannot be updated!!!–  
To verify calculated results, we can do it manually or by copying some or all of the datasheet into Excel. 
When in Design View, saving queries saves the query design, but when in Datasheet View, saving updates 
the underlying data.  To view long expressions, use (Shift + F2), the zoom function. 
Expression builder is like Excel’s formula builder because it helps to create expressions, provides access 
to built-in Access functions and allows me to perform date arithmetic as well. It can be opened as a 
dialogue box in which I can type my expression/formula and select categories and values by double-
clicking. 

 PMT function is meant to compute the monthly payment loan (monthly interest rate, term of the loan in    
months and original value of the loan. Its category in the dialogue box is Financial. 



Creating a conditional output with the IIF function (IIF includes the expression, its true part and its false 
part). The syntax will be such IIf( [name]= “Condition 1”, “Condition 2”, “Condition 3”) 
Performing date arithmetic can be done with date formatting and date arithmetic, and by using date 
functions Date, DatePart and DateDiff. 
Aggregate functions are calculations on an entire column of data and return a single value. Examples are 
Average, Count, Maximum, Minimum, Standard Deviation, Sum and Variance. To add aggregate functions 
to my datasheet, I must stay in the Home tab, select ‘Totals’, click the Total Row to aggregate functions and 
select the one(s) I want to compute. 
Forms are database objects used to add data into a table. The main reasons to use forms rather than 
tables are that they’re less likely to edit the wrong record by mistake, that they can show data from more 
than one table simultaneously and that they can create Access forms to match paper forms. 
Creating forms using the 16 different form tools include navigation forms, blank forms, etc. 
A record source is the table or query that supplies the records for a form or report. To identify it, I must first 
sketch its form and use the form tool to select if I want it stacked, tabular or laid out (layout view – best for 
employees). 
When using the Form tool to create a form, Access analyzes the table relationships created in the database 
and automatically adds a subform to your form. Subforms display records with foreign key values that 
match the primary key value in the main form. 
Split Form function combines two views of the same record source. One section is displayed in a stacked 
layout (horizontal) while the other is displayed in a tabular layout (vertical). 
Multiple Items function displays multiple records in a tabular layout similar to a table’s Datasheet view. 
VBA means Visual Basic for Applications. 
PivotTables and PivotCharts can be converted to Forms. 
Forms can be modified : a field can be added, removed, assigned a different width, fields can get a different 
order, label text can be edited and even colours themes/style can be modified. 
Revise forms by switching between form views, editing data in form view, altering a form in layout view and 
performing advanced changes to a form. 
Controls can be modified in the Design tab of the Form Design Tools section. There are controls for the text 
box, for the labels, for the styling and for calculations too. It is also possible to add new controls. 
A report is a printed document that displays information from a database in a format that provides 
meaningful information to its readers. 
Useful questions to ask oneself before creating a report are : 
- What is the purpose of the report? 
- Who will use/see this report? 
- Which tables are needed for the report? 
- What fields, labels and calculations are needed? 
- How will the report be distributed? 
- Will the results be converted to Word, Excel, HTML or another format? 
Access report tools to create reports are Report Design, Blank Report, Report Wizard and Labels tool. 
We can modify these by using the Layout or the Design view. 
The Report Wizard will ask questions. I should use 6 dialogue boxes to collect information and this will 
generate a report based on my answers. First, I will select a table/query. Then, I will add fields to the 
Selected Fields box. Then I will choose the sort fields, the order (ascending or descending) and click 
Summary Options if I want to add aggregate functions. Afterwards, I will have to choose the layout 
(stepped, block or outline) and the Orientation (portrait or landscape). The Adjust the field[…] option will 



adjust fields’ widths so they fit one page. Finally, I have to give a name to my report. I can also preview it 
and modify its design if I need to. 
Modifying a report includes adding new field(s), delete field(s), work with controls, adjust column widths, 
add a theme. 
Report Sections include a report header, below it a page header, below the PH a detail row, below the 
detail row a page footer and at the bottom completely, a report footer. 
Group & Sort in the Design tab can be used to add grouping. 
The Group Footer can contain the totals (the‘Count’ function). 
There are three different types of control : Bounded, Unbounded and Calculated. A report should usually 
contain a Calculated Control. 


